HYPE™

TAPE-TO-MP3 PORTABLE PLAYER AND CONVERTER

Model: HY-2010-TP
TAPE-TO-MP3 PARTS

1. EJECT
2. VOLUME ADJUSTMENT
3. HEADPHONE INPUT
4. USB CONNECTION
5. PLAY
6. STOP
7. FF/REW

RECORD YOUR CASSETTE TO YOUR WINDOWS PC

1. Setup

Connect the USB cable with your Tape-to-Mp3 player and your computer. No extra driver is required.
2. Audacity Installation
Insert the installation CD. Your computer will auto-run the program. Follow the instructions to complete installation.

If your computer does not auto run, click on the “Start” menu, select “Run” and choose the CD located on your computer and run “Setup.exe”

3. Run Audacity Program
Double-click on the Audacity program and the Audacity interface window will be displayed on your computer screen.
4. Playback Control Toolbar
   Audacity will display a control toolbar for you to edit and manage your recordings.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Button Image]</td>
<td>Moves the cursor to the start of the project.</td>
</tr>
<tr>
<td>![Button Image]</td>
<td>Plays your project from the position of the cursor. Use to listen to the audio in your project.</td>
</tr>
<tr>
<td>![Button Image]</td>
<td>Pressing the record button will record a new track from your computer's sound input device.</td>
</tr>
<tr>
<td>![Button Image]</td>
<td>Pause playback or recording. Press again to unpause.</td>
</tr>
<tr>
<td>![Button Image]</td>
<td>Stops playback or recording.</td>
</tr>
<tr>
<td>![Button Image]</td>
<td>Moves the cursor to the end of the project.</td>
</tr>
</tbody>
</table>

5. Playing Your Cassette
   Insert your cassette into the Tape-to-MP3 player and hit play.

6. Adjusting Input and Output
   Adjust the output and input volume.
7. Recording
Select the RECORD button to start recording while your cassette is playing.
Start playback on the cassette player. You will see the waveform of the audio on the screen as it is recording. You will hear the audio coming from the output of your computer's soundcard.
No Audio? - go back to the preference menu and make sure you have “Software Playthrough” selected and the speaker volume up on your computer.
Press Stop
SAVE YOUR FILE NOW by clicking on "File" followed by "Save Project"
Select the destination and file name for the project and click "Save"

Once finished recording, your screen should display your recording as below.
8. Editing your Recording
Audio Levels
Select your entire recording by selecting "Edit," then "Select..." then click "All."
Select the “Effect” menu and choose the desired effect. There are various types of effects which are described further on Audacity’s website. Selecting “Normalize” should be used to have Audacity auto-correct volume on the recording.
Noise Reduction
Drag your cursor over a portion of the audio track which contains unwanted noise. We recommend using the beginning or end of a track where there is no music and only noise.
- Select “Effect” and then “Noise Removal” from the drop down menu to bring up the “Noise Removal Window”

- Click “Get Noise Profile” and the window will close automatically.
- Select the entire track of audio you wish to remove noise from.
- Adjust the amount of audio that you would like to filter by moving the slider in the “Noise Removal” window.
Removal” window. We recommend using the minimum noise removal for optimum sound. Note: you can preview the audio before removing the noise by clicking on ‘Preview’.

- Click on ‘Remove Noise’.
The Editing Toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Cut button</td>
<td>removes selected audio data and places it on the clipboard.</td>
</tr>
<tr>
<td>The Copy button</td>
<td>copies the selected audio data to the clipboard without removing it from the track.</td>
</tr>
<tr>
<td>The Paste button</td>
<td>pastes whatever is in the clipboard into the track at the position of the selection cursor.</td>
</tr>
<tr>
<td>The Trim button</td>
<td>deletes all of the track except the current selection.</td>
</tr>
<tr>
<td>The Silence button</td>
<td>replaces the current selection with silence instead of removing it completely.</td>
</tr>
<tr>
<td>The Undo button</td>
<td>undo the last editing operation performed.</td>
</tr>
<tr>
<td>The Redo button</td>
<td>redo any editing operations that were just undone.</td>
</tr>
<tr>
<td>The Zoom In button</td>
<td>zooms in on displayed tracks displaying less time and giving a more detailed view of the track.</td>
</tr>
<tr>
<td>The Zoom Out button</td>
<td>zooms out displaying more time and a less detailed view of tracks.</td>
</tr>
<tr>
<td>The Fit Selection button</td>
<td>fits selected audio into the width of the screen to show the selection in more detail.</td>
</tr>
<tr>
<td>The Fit Project button</td>
<td>shows entire project in one screen.</td>
</tr>
</tbody>
</table>

The Tools Toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Selection Tool</td>
<td>use to select sections of an audio track to work on.</td>
</tr>
<tr>
<td>The Envelope Tool</td>
<td>this tool allows you to control how tracks fade in and out.</td>
</tr>
<tr>
<td>The Draw Tool</td>
<td>allows you to draw on the waveforms of individual tracks.</td>
</tr>
<tr>
<td>The Zoom Tool</td>
<td>zooms in or out of a specific part of the audio.</td>
</tr>
<tr>
<td>The Timeshift Tool</td>
<td>allows you to change the positioning of tracks relative to one another in time.</td>
</tr>
</tbody>
</table>

Before editing, you must make a selection of the
recording you would like to cut or copy. This will trim any music from the previous track, or any silence on the record between tracks.

- To select the part you wish to cut, copy or paste, use the selection tool. If it is not activated, do so by clicking on it in the toolbar.

- Press and hold the left mouse button while you drag the mouse to a marked area.

- This area is darker than the surrounding area of the clip. Note, even though you can mark an area larger than or extending beyond the actual audio clip in the track, the operations will only work on the actual clip. Playback however will work outside the clip.

- Press the space bar to listen to the audio in the marked area.
- To extend or contract your selection, hold down the SHIFT button and click on the area you wish your selection to extend or contract to.

- If you click at a spot that is on the right hand side from the middle of the current selection, you will set the right hand boundary of your new selection.

Now you must cut your selection. Select “Cut” from the “Edit” menu.
Create a new file and paste your cut into the new file.

9. Exporting to MP3
To export your recording to mp3 format, select “Export As” from the “File” menu. You will need to choose which format to export to. Choose “.mp3” as your file extension. When exporting, do not choose your Desktop as the destination folder. You can only choose “My Documents” folder. After export, you can move the files as desired.
For additional software information, please refer to http://audacity.sourceforge.net for detailed operating instructions.

Please note, Vibe is not responsible for software issues. If you have software problems, please contact Audacity through the website listed above.
ENVIRONMENTAL RECOMMENDATION

An electrical/electronic product should be disposed of in a manner that minimizes environmental impact as much as possible. The device should be disposed of according to local guidelines. The device can usually be disposed of at the local recycling station.

The WEEE Directive
The directive on waste electrical and electronic equipment (WEEE), which became European law on the 13th of February 2003, has led to a radical change in the handing of waste electrical and electronic equipment. First and foremost, the purpose of this directive is to reduce WEEE and also
to promote recycling, reuse and other types of recovery of this type of waste in order to reduce the amounts of disposal.

The WEEE logo on the product or on its packaging indicates that this product should not be treated as household waste. You are responsible for handing over all your electrical or electronic waste to the applicable collection points for the recycling of this type of hazardous waste. Separate and correct recovery of your electric and electronic equipment when it is discarded contributes to conservation of natural resources. Furthermore, correct reuse of electric and electronic waste contributes to the protection of human health and the environment. For more detailed information about disposal of electric and electronic waste, recycling and collection points, please contact your local city government, your household waste disposal service,
the shop where you purchased the product or the manufacturer of the product.

The ROHS Directive
On July 1, 2006, the ROHS Directive (www.Thiim.com/pdf/rohs.pdf) (2002/95/EC) came into effect. This aim of this Directive is to limit the use of hazardous substances in electrical and electronic equipment and to contribute to human health protection as well as environmentally sound utilization and disposal of electrical and electronic waste.
THE GUARANTEE IS INVALID

1. If the above is not observed.
2. If the device has been abused, exposed to force or other type of damage.
3. If there has been any unauthorized intervention in the device
WARRANTY INFORMATION

The condition of this warranty and our responsibilities under this warranty are as follows:
Supplier’s warranty is non-transferable. And this warranty is limited to the original purchaser only.
* You must be able to prove the date of original purchase of the unit with a dated receipt.
* The warranty is not applicable if the product has been subject to physical abuse, improper installation, modification or repair by unauthorized third party.
* The responsibility of supplier’s products shall be limited to the repair of replacement of the product as its sole discretion.
* Specifically exempt from any warranty are limited-life consumable components subject to normal wear and tear such as batteries, decorates and other accessories.
A supplier will not take any responsibility if the failure of the unit has resulted from accident, abuse, misuse, or any unauthorized repair, modification or disassemble.

Modification and repair of the unit should be done by authorized and qualified service personnel, Center or returned to the manufacturer.

This warranty gives you specific legal rights, and you may also have other rights which vary under local laws.

The following conditions comprise the requirements and scope of our warranty conditions and do not affect our legal and contractual warranty obligations. We offer a warranty on our products in accordance with the following conditions:

1. Hype™ products are covered by a 12 month warranty. We will resolve damages or defects on Hype TM products free of charge within 12 months of
the purchase date under the following warranty conditions. For any damage or defect determined later than 12 months after the purchase date, proof of a manufacturing fault must be submitted for repair under warranty.

2. The warranty does not cover batteries and other parts, which are considered consumables, parts that break easily such as glass or plastic or defects based on normal wear and tear. There is no warranty obligation in the event of marginal differences compared to the target appearance and workmanship provided these have a negligible effect on the product's fitness for use, in the event of damage caused by chemical or electrochemical effects, by water or generally from abnormal conditions.

3. The warranty will be performed in such a way that we shall decide whether to repair the defective parts or to replace them with working parts free of charge.
Hype™ reserves the right to exchange the product for a replacement product of equal value if the product sent in cannot be repaired within a reasonable time or at a reasonable cost. Requests cannot be made for repairs to be carried out on site. Parts that have been replaced or exchanged become our property.

4. The warranty claim does not apply if repairs or other work is carried out by unauthorized persons or if our products are equipped with additional parts or accessories that are not approved for our products.

5. Warranties that have been activated do not cause the warranty period to be extended, nor do they trigger a new warranty period. The warranty period for any replacement parts installed ends with the warranty period for the entire product.

6. Any other further claims are excluded, especially those for replacement due to damage caused to the
outside of the product, provided there is no obligatory legal liability. We therefore accept no liability for accidental, indirect or other consequential damage of any kind, which leads to usage restrictions, data loss, and loss of earnings or interruption to business.

Asserting a warranty claim:
1. To make use of the warranty service for hardware issues, you must contact the Hype™ Service Center by email at customerservice@dglusa.com
2. Hype™ will try to diagnose and solve your problem. If it is determined that a warranty claim exists, you will be given an RMA number (Return Material Authorization) and will be asked to send the product to Hype™.

IMPORTANT: Hype™ will only accept parcels that have an RMA number.

Please observe the following when sending the
product:
1. Send the product suitably packaged with carriage and insurance paid. Do not enclose any accessories with the product (cables, chargers, manuals, etc.) unless the Hype™ Service Center specifies otherwise.
2. Mark the RMA number on the outside of the package in such a way that it is visible and clearly legible.
3. You must enclose a copy of the sales slip as proof of purchase.
4. Once Hype™ has received the product, it will meet its warranty obligations in accordance with the warranty conditions and will return the product to the sender with carriage and insurance paid.

Service outside of warranty
Hype™ can refuse any service claim made that is not covered by the warranty.
If Hype™ agrees to provide a service outside the warranty, the customer will be invoiced for all repair
and transport costs. Hype™ will not accept any packages that have not first been approved by Hype™ by means of an RMA (Return Material Authorization).